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The Silent Partner MBL
The Silent Partner Meter Base Logger (MBL) offers unprecedented features and ease-of-use.
Logging residential voltage and current at the meter socket has the advantage of being noninvasive and easy to implement. The MBL is useful for troubleshooting customer complaints,
mitigating billing disputes and for energy conservation programmes.

Features
•
•
•
•
•
•
•
•
•

Transparent operation, regular meter works as normal.
Optional -40°C all weather operation for real world climates.
Optically isolated download for safe downloads in all situations.
Visual indication of suspected Loose Neutral and High/Low voltage.
Easy installation - plugs in to meter socket, meter plugs in on top.
Versatile neutral pickup - use fifth blade or flying leads (all included).
Weatherproof design (with meter affixed).
Line powered.
Fail-safe operation with internal 3 day battery backup and built-in recharger.

3- Sleep Switch
1- Neutral Contact
4- Reset Switch
2- Aux Power Input

5- Power L1 LED
6- Recording LED

8- High/Low Voltage LED

7- Loose Neutral LED

(Amber)

(Red)

9- Optically
Isolated
RS232 Port

1
2
3
4
5

Neutral Contact - versatile neutral hookup
Aux. Power - plug-in wall adapter for recharge
Sleep Switch - puts MBL in low power mode
Reset Switch - clears memory, starts logging
Power L1 LED - indicates L1-N voltage OK

6
7
8
9

Recording LED - blinks when MBL is logging
Loose Neutral LED - shows neutral faults
High/Low Voltage - shows surges, sags
Optically Isolated RS232 Port - allows safe
computer connections under all conditions.
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Quick Start
We understand that you may want to start using your MBL as soon as possible, and that you
might not want to take the time to read the manual to get going. Following these instructions will
get you up and running, but you should still read the rest of the manual for more detailed
information on how to get the most from your software.
•
•
•

Install and start the software.
The appropriate communications port will be installed at installation of software.
Connect the communications cable to the PC and other end to the logger.

To setup your logger:
•
•

Select the Logger menu and choose Change Parameters.
Configure the features of your logger as required. See Appendix – C on page 42 for full details on
what channel configurations can be used for power calculations.

To install the logger:
•
•
•
•
•

Remove the existing revenue meter and plug the MBL into the meter socket.
Check for the Power L1 LED and affix the locking ring if all is OK.
Press the Reset button on the MBL to start the logger, plug the revenue meter into the MBL and affix
the locking ring. Remember that pressing Reset clears all memory!
If you have a laptop computer, query the MBL to verify operation or to change the logger's behavior.
Remember to press the Sleep button before removing the MBL.

IMPORTANT!
IF YOU WANT TO CALCULATE POWER WITH THE MBL, YOU MUST ENABLE AVERAGE
RECORDING. REFER TO PAGE 26 FOR MORE INFORMATION ON THE CHANGE PARAMETERS
FUNCTION.

To download your logger:
•
•
•
•

Select the Logger menu; choose Download then after download choose the proper location for survey
to be saved. The default location is C:\Program Files\Silent Partner Pro\Data.
Select Ratio Selection to configure power calculation displays.
Select Scale Selection to choose the type of graph or Data to be displayed.
Select Zooming option for more details on you graph.

There are several sample data files supplied with Silent Partner Pro. To retrieve a file:
•
•

Using the File menu, select Open and select the survey file you would like to load.
Select Ratio Selection to configure power calculation displays.

See page 1642 for full details.

Viewing Power
To display kW, kVA, kWh, and kWh Cost information, follow these steps:
1.
2.
3.

Define your metering and power setup using the Setup menu and selecting Ratio Selection.
If you are interested in kWh costing, select the Costing menu, enter the relevant information and
check the Enable Costing box in Cost menu.
Select Graph or Data menu to see the appropriate graph, or the data in tabular format.

If you experience difficulties accessing the Range/Power box, refer to Appendix–C on page 42.
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A Short Primer on Residential Power Distribution

!

Please be sure to read this section. It contains important information about how the MBL
works with residential power systems, and how calculations are performed.

North American residential services use a distribution method that is commonly known as single
phase 3 wire (1P3W). It is sometimes called 'split-phase', or 'Edison circuit' distribution. In this
manual, it is referred to as 2P3W to make it clear that there are 2 phases monitored on the 3 wire
service. Regardless of what you call it, the configuration is basically the same.
The local utility supplies 2400 to 4800 volts that is reduced to 220 or 240 volts by a centre tapped
transformer. The center tap is bonded to ground at the main panel, where it becomes known as
'neutral'.

The result is two different 'phases' or 'legs' of 110 or 120 volts with respect to neutral (referred to
here as line-to-neutral voltage). If the connection is made across the two phases, there is 240
volts (referred to line to line voltage). This approach has several advantages:
•
•

It allows the use of standard 120-volt appliances as well as 240-volt appliances.
Since the two 120 volt supplies are 180° out of phase with respect to neutral, all currents
should cancel resulting in zero current on the neutral conductor (assuming no harmonics).
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Recognizing Common Problems with Residential Distribution
While residential services are generally less complex than three-phase industrial installations,
they do present their own set of challenges. The MBL has been specifically designed to monitor:
•
•
•

Loose / missing Neutrals
High and low voltage
Consumption

Loose Neutral-Related Problems
A 'Loose Neutral' is a situation in which the neutral conductor is intermittent or missing altogether.
This is often a result of corrosion, and usually deteriorates with time. Corroded neutral
connections often lead to arcing and burning of the neutral wire at the termination point.
What happens when there is a loose or missing neutral?
If the neutral conductor is completely disconnected, there will still be 240 Volts from line to line.
Depending on the load balance, one of the lines may end up being more than 120V, and the
other less than 120V, with respect to neutral. This is can be very dangerous, as it can destroy
electronic equipment, possibly start fires, and in some situations even create a shock hazard (i.e.:
some US jurisdictions require the stove frame be connected to neutral). Pronounced dimming of
lights when a load is engaged is often the first clue to a loose neutral. Also look for lights that are
brighter in one portion of a residence than others.
Keep in mind that brief brightening of less than 1 second can be normal if lighting and large loads
like motors share the same 240V circuit. A loose neutral in the main panel will usually show
increased brightness in excess of one second.
How Does the MBL Determine if there is a Loose Neutral?
The MBL uses a simple process to determine if a line problem might be caused by a loose
neutral. Diagnosis is straightforward if you consider the following:
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•

Since the line to line voltage is obtained across L1 and L2, it
can be assumed that the voltage supplied to Line 1 and Line
2 is OK if the line to line voltage is close to 240 volts.

•

If the line to line measurement across L1 and L2 is not close
to 240 volts, then there is likely a problem with one or both of
the lines. This can be due to a faulty transformer, defective
wiring from the transformer to the meter socket, excessive
loading, etc.

•

If the line to line measurement is close to 240 volts, but there
is a large difference between L1 and L2, then there may be a
loose neutral problem

In other words, if the line to line voltage is within the SETPOINT value ± the DEVIATION VALUE
AND the difference between Line 1 and Line 2 is greater than the DIFFERENCE VALUE, THEN
a loose neutral may exist.
Silent Partner software enables you to change the values used for setpoint, deviation value (also
referred to as tolerance) and difference value.
Example
The MBL is initialized with a setpoint of 240V, a deviation of 20V and a difference value of 10V.
As long as the line to line voltage is between 220V and 260V and the difference between Line 1
voltage and Line 2 voltage is greater than 10 volts, the Loose Neutral LED will light. So if the
logger were to read 250V line to line, 109 volts on line 1 and 150 volts on line 2, the LED would
light.
Setpoint
(240V ±20 Volts Deviation)

Line 2

Line 1

20
20
Line to Line

Volts

260
240
220
200
180
160
140
120
100
80
60
40

Difference
in voltage
between
Line 1 and
Line 2
exceeds
10V, so
LED lights.

The numbers in the chart above will change depending on how you set the values for the
setpoint, tolerance and line difference values.
Stated mathematically,

(L2LSetpoint − L 2 LTol ) > Line to Line Reading > (L2LSetpoint + L 2 LTol )AND( L1 − L 2

> Line Diff

)

where:
L1:
L2:
L2L Setpoint:
L2LTol:
Line Diff:

= Line 1 voltage.
= Line 2 voltage.
= Line to line Setpoint (default is 240).
= Allowable line to line voltage deviation.
= Allowable difference between line 1 and line 2.

The LED is latched, meaning that once a loose neutral condition has been detected, the LED will
remain lit until the MBL is reset.
Note: The external LED's are switched off whenever the logger is in sleep mode. If you have set
the logger not to use wrap-around memory, the logger enters sleep mode at the end of memory
and extinguishes all of the LED's.
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You can also use Silent Partner software to identify loose neutrals quickly and easily.

Line 2
voltage
surges to
145V

Line to line
Voltage
appears
normal at
230V

Line 1
voltage
dips down
to 59V
Indicates that a
Loose Neutral
problem may
have occurred.

Using the line-to-line and line-to neutral values provided by the MBL allows you to differentiate
neutral problems from balance and supply problems. Loose neutral indication is also available on
tabular data displays.

High/Low Voltage:
Voltage that is too low or too high can damage equipment and adversely affect efficiency. Large
voltage deviations under load can be a useful indication of supply 'stiffness.'
The High/Low Voltage LED will light when the value of either Line 1 or Line 2 is above or below
the nominal line voltage. The nominal line voltage is always one half of the line-to-line setpoint
used for the loose neutral LED. Using the example above, the setpoint value would become ½ of
240 volts = 120 volts. If we were to choose a tolerance of ±10 volts, the LED would light
whenever line 1 or line 2 exceeded 120V+10V, or whenever either line fell below 120-10V. In
simple terms, the LED will light if either leg is not within the window of 110V to 130V.

L-N
Setpoint
120V
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150
140
130
Volts 120
110
100
90
80

The High/Low
voltage LED
lights if voltage
on either line
falls outside this
area.

The High/Low LED is illuminated when these conditions are met:


 L2LSetpoint

 L2LSetpoint
− HLVTOL  > Line1Reading > 
+ HLVTOL 

2
2




OR


 L2LSetpoint

 L2LSetpoint
− HLVTOL  > Line 2 Reading > 
+ HLVTOL 

2
2




Where:
L1:
L2:
L2L Setpoint:
HLVTol:

= Line 1 voltage.
= Line 2 voltage.
= Line to line Setpoint (default is 240).
= Allowable line to neutral voltage deviation.

Like the Loose Neutral LED, High/Low Voltage LED will remain ON until the MBL is re-initialized.

Why Does the MBL Measure Line-to-Line and Line-to-Neutral?
Some loggers developed for use on residential services only measure line-to-neutral voltages,
and then calculate the line-to-line voltage by summing the two. The MBL measures line to line
and line to neutral for two reasons:
1. Loose Neutrals: If the neutral connection is lost, line-to-neutral values can become
indeterminate. Depending on the metering setup, they may be completely wrong. If the
neutral connection is intermittent, there is no way to differentiate between a supply fault and a
loose neutral. The MBL uses the measured line-to-line voltage in conjunction with the
difference between L1 and L2 to indicate a suspected loose neutral condition (see page 4).
2. Better Accuracy: Calculating line to line voltage only works as long as there are no phase
shifts between L1 or L2, whereas measurement works in any case.
For example, when both line 1 and line 2 are in phase (i.e. both L1 and L2 have the same
phase angle), the vector sum of the voltages is:

E L1 = 120V∠0°
E L 2 = 120V∠0°
Which can also be expressed as:

E L1− L 2 = (120 cos(0 ) + j120 sin (0 )) + (120 cos(0 ) + j120 sin (0 ))
E L1− L 2 = 240 + j 0
E L1− L 2 = 240 Volts
As you would expect, the sum of the two 120V phases is 240 volts when they are both in
phase. However, if we were to assume a 15° phase difference:
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E L1 = 120V∠0°
E L 2 = 120V∠15°
E L1− L 2 = (120 cos(0 ) + j120 sin (0 )) + (120 cos(15) + j120 sin (15))
E L1− L 2 = 235.91 + j 31.06
 31.06 
 = 7.50°
 235.91 
235.91
∴ E L1− L 2 =
cos 7.5°
E L1− L 2 = 237.95 Volts

θ = arctan

Here you can see that simply adding L1 and L2 would still give 240 volts, but measuring it would
correctly report 237.95 volts. The greater the phase difference between L1 and L2, the more
pronounced the effect. In short, the MBL gives you an accurate picture of what's happening,
regardless of the phase relationship of L1 and L2.

What Causes Phase Shifts between L1 and L2?
Phase shifts in a residential service are most often the result of a severe load imbalance between
lines where a significant amount of current is flowing in one line, but not the other.
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Meter Socket Basics
The Meter Socket provides a convenient point for monitoring power consumption. Residential
meters are usually (but not always) located on the exterior of the structure. Locations and blade
configurations may vary from one jurisdiction to another, but the basics still apply. The diagram
below shows a typical meter socket.
Line 2 from Utility
Line 1 from Utility

L2 to Main
Panel
Disconnect
L1 to Main
Panel
Disconnect
Power comes in from the utility into the two blades on the top of the panel. Current flows from the
top blades, through the revenue meter through to the bottom blades which are connected to the
main disconnect inside the house.

Logger Hookup
The MBL has been designed to fit in-between the existing revenue meter and the meter socket
(see below). The design has been optimized to accommodate most existing residential meter
bases, so installation generally follows these steps:
1. Remove the existing revenue meter from the meter socket.
2. Plug in the MBL into the meter socket.
3. Check for the Power L1 LED. This is Important! If the neutral is not hooked up correctly,
the LED will not light or be very dim, and all line to neutral measurements will be
incorrect! See page 13 for details on how to resolve connection problems.
4. IF the LED is ON, affix the MBL locking ring and press the reset button to start the logger.
5. Plug the revenue meter into the MBL and affix the meter locking ring.
6. If you have a laptop computer, query the MBL to verify operation or to change the logger's
behavior.
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Meter Socket

MBL

Revenue Meter

The primary difference from one installation to another concerns the implementation of the neutral
conductor. Depending on the local electrical code and the application, the meter socket will
usually be one of these types:

'Network' Service
These installations have meter sockets with a fifth blade to allow connection to the
neutral directly. The blade can be in the 6 o'clock or 9 o'clock position. This type of meter
socket is often referred to a network service or transformer-rated service.

Fifth Blade
(May also be in the
6 o'clock position)

The MBL includes a fifth blade to mate with the neutral in this type of socket in either the
9 o'clock or the 6 o'clock position. If the MBL's neutral blade is not in the correct position,
remove the neutral wire quick-connect, then release the cotter pin on the reverse side of
the blade.
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Remove
cotter pin to
move blade.

Move blade
to 6 o'clock
position as
required.
Slide the blade out and carefully re-insert it into the correct position, then reconnect the
neutral wire. A good neutral connection is confirmed by the Power L1 LED lighting when
the logger is plugged into the meter base (assuming L1 voltage is present).

Exposed Neutral
Meter sockets with an exposed neutral have a neutral strap in the centre of the meter
socket. This strap usually has screw terminals to join the incoming neutral with the main
disconnect.

Neutral Strap
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The MBL includes several accessories for connecting to the neutral in this configuration
(see below). These attachments are connected to the neutral socket on the rear of the
MBL.

Neutral
Socket

Short Lead

Long Lead

Short Lead:
A 10" lead is provided with the MBL to connect to the neutral strap. Simply
connect the lug to an available screw on the neutral strap and then plug the
shrouded plug into the back of the MBL. As you seat the logger into the socket,
be careful that the lead is not pinched by any of the blades.

Long Lead:
A 36" lead has been provided. This lead should be long enough to pass through
the conduit and into the distribution panel. Connect the lug to the neutral strap
inside the panel, then plug the shielded plug into the neutral connector on the
back of the logger. As you seat the logger into the socket, be careful that the lead
is not pinched.
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Inaccessible Neutral
These installations are characterized by a completely unbroken and continuously
shielded neutral conductor.

The neutral conductor passes through the meter socket directly into the main disconnect
and distribution panel. In this case, a long lead (36") lead has been provided. This lead
should be long enough to pass through the conduit and into the distribution panel.
Connect the lug to the neutral strap inside the panel, then plug the shielded plug into the
neutral connector on the back of the logger. As you seat the logger into the socket, be
careful that the lead is not pinched.

Power L1 LED
When the MBL has been properly installed and the neutral connected correctly, the Power L1
LED should be lit. The LED indicates that there is voltage present on L1, and that the unit is being
powered from the line.

IMPORTANT!
If the Power L1 LED is not ON, it may mean that the neutral connection is faulty!

Troubleshooting MBL Connections
If the Power L1 LED is not lit after installation, verify that the neutral connection is properly
secured. If the neutral to MBL connection is okay, check for voltage on line 1. You can do this
with a voltmeter or by hooking up a laptop computer to the MBL and using the Read Status
command (see page 25).
•
•
•

If you can read 120V from L1 to neutral, there is a problem with the MBL-to-neutral
connection.
If you read 0 volts from L1 to neutral and 120V from L2 to neutral, then there is a problem
with L1.
If you read 240 volts from L1 to L2, the problem is likely a loose or missing neutral.

If everything above checks out, the absence of the L1 Power LED can also be an indication of a
loose or missing neutral from the utility transformer to the meter socket. If the lack of power on L1
is a temporary situation, remember that the MBL will operate from battery power for
approximately 3 days when fully charged.
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Loose Neutral LED and High/Low Voltage LED
The MBL has external LED's to indicate suspected loose neutral conditions and the occurrence of
high or low voltage.
Loose Neutral LED:
If the line to line voltage is within a "normal" range but the difference between the two phases
exceeds a predetermined value, a potential loose neutral condition may exist.
The LED is latched, meaning that once a loose neutral condition has been detected, the LED will
remain lit until the MBL is reset or put into sleep mode.
A complete description of the MBL and loose neutrals can be found starting on page 4.

High/Low Voltage LED:
The High/Low Voltage LED will light when the value of either Line 1 or Line 2 is above or below
the nominal line voltage, ± an allowable deviation. Full details on how the High/Low LED is
triggered can be found on page 6.
Like the loose neutral LED, the High/Low Voltage LED is latched and will remain ON until the
MBL is re-initialized.

Downloading and Disconnecting the MBL
After your survey is complete, you can choose to download your data on-site with a laptop
computer or to take the MBL back to the office.
To download on-site:
1. Remove the rain cap on the MBL COM port.
2. Connect the download cable to the MBL.
3. Connect the download cable to the computer.
4. Start Silent Partner software Pro and download the data. Please note that downloading does
not clear the data from memory, so you can download as often as you wish without
interrupting recording.
5. Re-initialize the logger if desired (to clear LED's and memory).
6. Remove the download cable and replace the rain cap.
To remove the MBL:
1. Remove the revenue meter locking ring.
2. Remove the revenue meter.
3. Press the Sleep button on the MBL. This puts the logger in low power standby mode. It's
always a good idea to put the logger into Sleep mode when disconnecting or transporting the
logger. This minimizes the risk of data loss, and prevents the logger from recording "0 volts"
when removed.
4. Remove the MBL locking ring.
5. Remove the MBL.
6. Replace the revenue meter and the locking ring to the meter socket.
7. The MBL can be downloaded at any time. In sleep mode, the MBL will retain data for about 6
months. REMEMBER - If you press the RESET switch, you will erase all data in memory and
restart the logger.
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Internal Power Supply and Rechargeable Battery
The MBL has an internal power supply that powers the logger when there is voltage present from
Line 1 to neutral. The power from this supply is used to power the logger and charge the internal
battery. The type of rechargeable battery used in the logger depends on the model:
MBL40:

- Lead Foil Battery. Software reports low battery at 4.0 volts.

Battery Recharging
The MBL contains an internal rechargeable battery and integrated charging circuitry. The MBL
will recharge and maintain the battery when plugged into a powered meter socket, or when the
external AC adapter is used.
The MBL has 2 charging modes: Quick Charge and Trickle Charge. Quick charge allows the
logger to fully recharge in 7-8 hours with a plug-in wall adapter, while trickle charging is used to
maintain the charge over time.
Quick Charge
Quick Charge is active whenever the following conditions are met:
•
•

The external AC adapter is plugged in.
The RESET button is pressed and battery voltage is below 4.5 VDC (MBL40).

After the battery is charged to 4.5 VDC (MBL40), quick charge is turned off until the voltage falls
below 4.0 VDC.
Quick Charge is not active when the MBL is in sleep mode. A full recharge will take 7 to 8 hours
in quick charge mode. Quick charge current is usually around 120 mA.
Trickle Charge
Trickle Charge is active whenever the logger is not in Quick Charge mode. Any time power is
applied from L1 -N or the external AC adapter is plugged in, the battery is trickle charged at
approximately 6 mA.

Silent Partner Pro Software
Silent Partner Pro software enables you to calculate power values using measured current,
measured voltage and an assumed power factor. Simple drop down menus allow you to quickly
define your metering setup. You can also calculate power for any data files you may have already
created with the standard Silent Partner Pro software.

Features
•
•
•
•
•
•

kVA, kWatt, kWh, kWh Cost (and totals).
Display and print power graphs and tables.
Summarized data for power values on the summary page.
Full support for all Silent Partner Current Loggers.
Download and display graphs and tables for all Silent Partner loggers
Real Time Meter Mode
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Installing Silent Partner Pro Software
System Requirements:
Windows XP & 7 32Bits and Windows 7 and 8 64Bits
VGA display
Serial communications port or USB port
Hard disk with 30 megabyte free
Your computer must be IBM compatible, running Windows XP & 7 (32Bits) and Windows 7 and 8
(64Bits) , with a VGA display, and a hard disk or network drive with at least 30 megabyte of free
space. Although not essential, a mouse makes using the Silent Partner Pro software much easier
and faster. You should be familiar with running applications in Windows.
To install the software:
•
•
•

Make sure that your computer is running Windows.
Insert the Silent Partner Pro distribution CD in CD drive.
Follow the on-screen installing instructions.

A program group called Silent Partner Pro will be created containing the Silent Partner icon. As
with any Windows application, the Silent Partner Pro software is run by double clicking the icon
with the mouse.

Using Silent Partner Pro Software
There are several options that can be set up to control how graphs are displayed, the directories
that Silent Partner Pro uses, etc. For details on these option settings, please refer to the section
entitled Setup (page 28).
A Short Note About the Time and Date Format:
The time and date format in the various reports will appear in the format you have selected in the
International Settings section of Windows Control Panel. For instance, if you setup Windows to
use 24 hour time format, Silent Partner will display all times in military or 24 hour format.
After double clicking the Silent Partner icon, the opening screen will appear.
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After a few seconds, the title screen will disappear and the main title bar will appear.

The main menu is divided into five sub-menus; File, View, Logger, Windows and Help. If a
selection in a menu is dimmed out or you can’t select it, it means that that particular choice is not
available to you. This may be due the fact that there is no data loaded (e.g. trying to View a graph
when you have not loaded or downloaded any data yet), or it may be a feature only available to a
different type of Silent Partner logger.
A summary of each menu and its associated functions follows.

Silent Partner Pro Command Summary
Each main menu has an associated drop down menu that allows you to execute a particular
function. Below is a brief description of each menu and all of its related functions.
File
The File menu groups all of the functions required to manipulate Silent Partner data files.

Open
Retrieves a previously stored survey file. Selecting Open will display the file selection dialog box:
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To retrieve a file, double click on the files name from the pick list or enter the file name in the file
name box and click on OK. If the file you wish to retrieve is not in the current directory, you can
select a different directory using the directory tree list, or by entering the directory name. The
default directory is the directory specified in the Silent Partner Pro directories section of the
program (see page 28 for more details).
Save
Saves changes to the survey you have been working on. This function is useful if you have
downloaded a file but opted not to save it at the time of downloading, or if you have changed the
summary information or notes and want to update the survey file. The survey is re-saved under
the original file name if it was saved before, otherwise you are prompted for a file name. To save
a changed file under a different name, use the Save As function. When you choose Save, the
survey remains loaded so you can continue working with it if you wish.
Save As
Saves a new or existing survey. You can name a new survey or save an existing survey under a
new name. The original survey remains unchanged. When you choose Save As, the survey
remains loaded so you can continue working with it if you wish.
Delete
Deletes a survey file. The file select dialog will appear to allow you select which file to delete.
Export
Translates the current survey into CVS, MS Excel, MS Word and HTML format. The time and
date of each measurement is exported, along with the reading. This feature allows you to transfer
your data into spreadsheet and graphics programs to create custom reports.

Print
Prints out the report that is currently on the screen. You can also choose which printer to use, and
setup certain features of your printer.
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The top of the Print dialog box will tell you which printer is currently selected. The Print Range
section allows you to define the days that are included in the printout. For example, you could
print one or two days of graphs from a 30-day survey (this can save a lot of paper). To change
the date range, select the Dates selector. Choose the starting and ending dates using the sliders
below the From and To headings. You can also select whether or not to print a summary report
with each printout. The summary report contains statistical information, user notes and the start
and stop times of the logger.
Note: The statistics printed are based on the selected print range, not the entire logging
period.
Clicking the Setup button will allow you to choose which printer to use, and to change certain
options for the printer.

The Default Printer is the primary printer as specified by the Printers section in Windows Control
Panel. If you want to print to another printer, select the Specific Printer selector. You will then be
presented with a list of the available printers installed in Windows. If the printer you want to use is
not on the list, you must load the appropriate Windows driver. For information on installing
Windows drivers, please consult your Windows manual.
Clicking the Options button will allow you change the operational setup of your printer. Here you
can change printer options such as print darkness, resolution, orientation, etc. The options
available will vary depending on the printer you have. Please note that the summary page always
prints out in portrait mode.

Exit
Quits the program.

View
The View menu allows you to select how to display the Toolbar and Status Bar.
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Survey Summary

Displays summary information and notes about the current survey. This information is useful for
finding out how long the MBL was actually logging, when it was started, when it stopped logging,
and the range for each channel. You can also enter in a survey title, notes, or other descriptive
text to identify your report. Selecting the Range button allows you to setup power calculation.
Selecting the Min/Max: button will display the minimum and maximum values for the
measurements you are displaying:

Minimum value for
channel 2 current.
Maximum value for
channel 2 current.

These values are also printed on the Summary Page when printing.
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Measurement Graph

Displays a graph of each measurement according to time. The number of days along the bottom
of the graph is set using the Graph Length selector in the Display/Print Options menu (see
page 30 for more details).
The scale on the Y-axis can be changed using the Measurement Scale function in the Setup
menu (see page 28 for more information). The Y-axis can also be zoomed or unzoomed via the
View menu (page 19). The graph can be scrolled horizontally by clicking the mouse on the scroll
bar at the bottom. It can also be scrolled using the keyboard:
•
•
•
•

←and → move the graph forward or backward by one period.
Home will return the display to the beginning of the survey.
End will advance the display to the end of the survey.
Page Up and Page Down advance the graph by one full period. For instance, if you are
viewing a 7-day graph and press Page Down, the next 7 days will be displayed.

Loose Neutral Indicator
Silent Partner can be setup to analyze MBL for indications of suspected Loose Neutrals. When
the conditions set in the Neutral Configuration screen are met, Silent Partner plots a "?" at the
bottom of the graph. Plotting of the symbol can be turned on and off in the Display/Print Options
function on page 30. For details on loose neutral calculations see page 4.
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Measurement List

The measurement list is a listing of the actual readings and the time and date on which they
occurred. This list represents the same data as the Measurement Graph, only in numerical form.

Channel 1
Current.

Time
Date

Channel 2
Current.

Channel 2 Line to
Neutral Voltage

Possible Loose
Neutral indicator.
"." indicates a
normal condition.

Channel 1 Line to
Neutral Voltage

Record
Number

"?" indicates a
possible loose
neutral condition.

For details on loose neutral determination, refer to page 4.
The list can be scrolled vertically by clicking the mouse on the scroll bar on the right hand side.
The list can also be scrolled using the keyboard:
•
•
•
•

↑ and ↓ moves the list up or down one item.
Page Up and Page Down will move the list up or down by one page.
Home will move to the beginning of the list.
End will move to the end of the list.
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Zoom
Zoom allows you to see more resolution (detail) when viewing graphs. In the unzoomed mode,
the Y - axis will be scaled from the lowest to the highest value in the logger’s range. For an MBL,
the unzoomed Y-axis would be scaled from 0 to the full-scale value of 200 amps and 120 volts. If
you select Zoom, the software will scan the data to obtain the highest and lowest values
recorded. These two values will then be used as the upper and lower Y-axis values.
Logger

Before using any of the following functions, the logger must be connected to the correct serial
port. Serial ports are usually found on the back of the PC, and are always either a male 9-pin
connector or a male 25-pin connector.
If your computer has more than one serial port, make sure you connect to the same port that you
specified in Setup. If you are not sure which port you are connected to, you can have Silent
Partner find that out for you. For details on selecting or searching for serial ports, Please refer to
the section in Setup called Logger Serial Port on page 28 for more details.
Set Time and Date
Synchronizes the MBL's internal clock to the time and date of the computer's clock, clears
memory and resets the logger. After selecting this function, Silent Partner will stop to confirm that
you really want to clear the logger.
REMEMBER – SETTING THE TIME CLEARS ALL MEMORY !

Selecting Cancel will abort the operation. Selecting OK will set the logger time to the computer’s
time and clear the memory.

Since the PC’s time is sent to the logger, it is important to make sure that your computer's time
and date are correct.
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Read Status

Read Status displays operational information about the logger such as logger type, firmware
revision, record count, clock time, present reading for each channel, channel configuration,
battery voltage, and whether wraparound recording is enabled. This is a useful function for
verifying that the logger is operating properly and communicating with the PC.
Download Data
Retrieves all of the data from the MBL. Note that downloading an MBL logger does not destroy
the data, so the logger can be downloaded as often as you want. For other types of loggers,
consult the operations manual before downloading. Before downloading, connect the MBL to the
download cable, and then connect the cable to the back of your computer. Please note that
communications ports on most PC's are 9 pin or 25 pin male connectors. If your port uses a 25pin connector, you may need to use a 25 to 9 pin adapter (available at most computer stores).
After selecting Download Data, Silent Partner will inform you that it is initiating communications
with the logger. As the data is transferred, you will see a completion gauge telling you how the
download is progressing.

After downloading, a short message is displayed about the amount of data transferred. Next, you
will be prompted to fill in the summary information screen. This screen allows you to enter in a
survey title as well as several lines of notes. The notes section is often used to record such items
as site details, the logger serial number, contact names, addresses, etc.
Pressing the RANGE… button lets you to examine the current range scaling for each channel.
When the summary information looks correct, press the OK button and the file save dialog
appears. MBL files all use .MLS, for an extension, and this is automatically appended to all file
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names. If you don't want to save the file or you want to look at the data first, you can press the
Cancel button. You can save the data at any time later using the Save option in the File menu.
After pressing the OK or CANCEL button, the screen will clear and the Measurement Graph will
be displayed. You can view your data in graphical or tabular form by choosing one of the display
types from the View menu. For further information on display types, please see the section
regarding the View menu on page 19.
Change Parameters
Change Parameters allows you to configure how the logger will operate.

Samples
By moving the slider, you can set how often the logger will store a reading. When you move the
slider, the values for the Storage Interval and the Survey Length will automatically change. As
you increase the Storage Interval, the Survey Length also increases.
Wraparound Mode
Checking the Wraparound Mode box causes the logger to replace the oldest data with the newest
reading when the end of memory is reached. This feature is useful for making sure you always
have the most current data. If the Wraparound box doesn’t contain a , the logger will stop
recording when memory is full and enter SLEEP mode to conserve power.
Channel Configuration
Checking or unchecking each box allows you to enable or disable recording for individual
channels. Disabling channels allows you use the memory allocated to the disabled channels to
record longer surveys. Beside the check box is the currently selected channel sensor and range
for each channel. If there is no text beside the channel name, the channel is configured the
same as the channel above it. To change the range, see below. If you plan to use your data to
calculate power, refer to Appendix – C on page 42 to ensure you configure the logger channels
correctly.
Min/Max and Average
Checking or unchecking the Min/Max or Average boxes allows you to choose which values the
logger stores. Minimum values are the lowest reading collected by the logger during the storage
interval, and Maximums represent the highest reading collected during the storage interval. The
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Average value represents the mathematical average of all of the readings taken during the
storage interval.

VERY IMPORTANT!
IF YOU PLAN TO CALCULATE POWER WITH YOUR DATA, YOU MUST ENABLE AVERAGE
RECORDING.

Power cannot be calculated using instantaneous minimums and maximums, because voltage and
current highs and lows may not occur at the same time (minimums and maximums can occur at
any time during the recording interval).
Range …
The range setup screen lets you to setup how power is calculated. For a full description of the
Range/Power functions, please refer to page 32.
Neutral …
The Neutral button allows you to setup how the LED's on the MBL function.

Loose Neutral
Setpoint (V):
Tolerance (+/-V):
|L1-L2| (+/-V):
Over/Under Voltage
Setpoint (V):

Tolerance (+/-V):

Defines the Nominal line to line voltage.
Defines the amount of deviation from the nominal line to line voltage.
Defines the maximum allowable difference between line 1 and line 2.

Defines the nominal line to neutral value. This number is automatically
set to ½ of the Loose Neutral voltage setpoint.
Defines the maximum allowable deviation from the nominal voltage
before the High/Low LED lights.

WARNING-CHANGING LED SETTINGS WILL RESET THE LOGGER AND CLEAR MEMORY !
Press OK to update the logger with the new limits. For a detailed explanation of how these values
are used by the MBL, please refer to page 4.
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Sensor
Sensor values are predefined for the MBL and are not configurable.
Update
Click on this button when you wish to send the new parameters to your logger.
UPDATING PARAMETERS WILL RESET THE LOGGER AND CLEAR MEMORY!
Please be certain this is what you want to do before clicking on Update. Click Cancel if you
decide not to change any of the logging parameters. The software checks the MBL's battery
voltage before sending the new configuration. If the battery voltage is below 4.8 volts for an
MBL20 or below 4.0 volts for an MBL40, a warning is displayed suggesting that you recharge the
battery. For more information on recharging, please refer to page 15.

Setup
The Setup menu allows you to specify how graphs and tables appear, where data is stored, and
other operational options of the program.

Logger Serial Port
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The Logger Serial Port function lets you select which communications port the MBL is
connected to. If you experience problems communicating with the logger, make sure you have
selected the correct port. If you don't know which port your Silent Partner is connected to, you
can use the Scan Ports for Logger feature. Selecting this feature initiates an automated search
of all the installed serial ports for the presence of a logger. To search for the correct serial port,
follow this procedure:
•

Select Meter Logger in the Select Logger Type box.

•

Plug the download cable into the back of the PC. Serial ports are always either a 9-pin male
DB9 connector or, on older computers, a male 25-pin DB25. Connect the other end to the
logger. Some loggers such as the ERA and DURA loggers may require the use of a special
interface rather than just a download connector.

•

Click on the Start Port Scan for Logger button.

•

The software will begin to search all of the available serial ports installed on your computer
for the presence of a logger. A dialog box informs you which port is being tested, and whether
or not a logger has been found.

•

If the software reports that a logger was found, that serial port will be selected as the
download port when you press OK.

•

If the software does not find a logger, try moving the download cable to another connector at
the back of the computer. If you still cannot communicate with the logger, there may be a
problem with your computer's communications interface.

ML Options
This section allows you to set some of the enhanced communications features of the MBL.
9600 Baud - Sets the default download speed to 9600 baud.
19k2 Baud - Allows downloading at increased rate of 19200 baud. This option should
only be used if you have a fast (Pentium class) computer. Slower computers
may experience transmission errors at this increased speed. If you
experience incomplete downloads at the 19k2 baud rate, switch back to
9600 baud.
XON/XOFF- Enables handshaking control. This setting allows the computer to signal the
MBL when it can't handle any more data. Once the computer has caught up,
it will signal the MBL to resume data transmission. This option should
normally be ON.

Survey Description
Allows you to edit or change the survey file summary notes. For a complete description of the
survey summary, please refer to the View menu (page 19).
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Display/Print Options

Graph, Print List Length
Allows you to select the period displayed on the X - axis (bottom) of the measurement graph.
Overview Graph Style
The overview graph is only available for SPA activity loggers and is not used with the MBL.
Measurement Y-Axis
Silent Partner allows you to select the number of Y - axis scales to use when recording two or
three channels. If you select Single, all channels will be plotted against a single scale, located
on the left-hand side of the graph. This is useful when you are trying to compare two similar
trends against the same scale. If you select Dual - Left/Right, channel 1 will be plotted
against the scale on the left-hand side of the graph and channels 2 and 3 will be plotted
against the scale on the right hand side. Multiple scales are useful when the readings on each
channel are significantly different.
Trace Selections
Trace Selections allows you to show or hide individual traces on the graphs. Checking the box
beside the trace name will cause the trace to be plotted, whereas clearing the check box will
hide the trace. This feature is handy for removing screen clutter, especially if you have
recorded min, max and average values for all three channels. If the trace names for a
particular channel are dimmed out, the channel was not recorded or does not apply to the
measurements selected and therefore cannot display any data.
Pressing the All On button will select all traces for display.
Loose Neutral Markers
Selecting the Loose Neutral Markers box enables Silent Partner to plot a "?" wherever a loose
neutral condition may have occurred. The marker can be displayed on graphs and tables. For
more information on loose neutrals and how they are determined, refer to page 4. For
information on how to set the values used for the loose neutral calculation, see below.
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Neutral …
The Neutral button allows you access to the loose neutral setup screen.

Setpoint (V):
Tolerance (+/-V):
|L1 - L2| (+/-V):

Defines the Nominal line to line voltage.
Defines the amount of deviation from the nominal line to line voltage.
Defines the maximum allowable difference between line 1 and line 2.

This function is similar to the neutral setup in the Change Parameters screen, except it
controls how loose neutrals are calculated in the software only (the logger settings are
unchanged). The setting in Change Parameters is used to setup how the LED's on the logger
function, as well as how the software will behave. Keep these points in mind:
•
•

When a logger is downloaded, the software uses the settings programmed in the MBL.
Whenever a survey is saved, the current Loose Neutral settings are saved along with the
data.

For a detailed explanation of loose neutral determination, please refer to page 4.
Measurement Scale

The measurement scale allows the user to select the units of measurement for the logger
readings:
•
•

Raw Data is the actual sampled data stored by the logger with no scaling or engineering
units applied.
Scaled Data displays the data with the correct scaling and units as specified when the logger
was initialized (see section on Change Parameters on page 26).

If you have configured the software to calculate power, you will also see choices for power
quantities such as kVA, kW, and kWh. See below for details on setting power parameters.
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Range/Power
The Range/Power setup box lets you define how power is calculated.

Channel Ratio
The Channel Ratio box displays the current range setup in use by the logger. This setting
cannot be changed for the MBL.
Supply Type
The Supply type box is used to tell Silent Partner what kind of power distribution system you
are measuring. For the MBL, this will always be a 2 phase 3 wire (2P3W) supply:

Calculate power based on a 2phase 3-wire residential system.

Calculations will use 2 measured
currents and measured voltages.

Load Type (PF)
Load type allows you to choose the power factor to be used in all power calculations. You can
pick values from the drop down list of common power factor values, or you can enter your own
power factor value directly. Allowable range for power factor values is from 0.1 to 1.0.
Voltage
Source
The source selection allows you to specify where the voltage values used in the
power calculations come from. The MBL has a fixed configuration, so the box is set to
Ch.3,4 by default.
Range (P-N)
The Range box specifies the nominal voltage range used in the power calculations.
Since the MBL uses fixed ranges, the only choice is 120V. The label after range is (PN) indicating that the voltage is a phase to neutral value.

Indicates that this is a phase to
neutral voltage.

PT Ratio
PT Ratios are not selectable for the MBL.
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Current
Source
Specifies which channels provide the current values for the power calculations. The
MBL has a fixed configuration, so the box is set to Ch.2,5 by default.
Range
The current Range box specifies the current range selected in the logger setup. The
MBL uses a fixed range of 180A.
External CT
External CT ratios are not selectable for the MBL.

Directories

Specifies where survey files and export files are located. The Data File Directory is the directory
that Silent Partner will store all downloaded data. It is also the default directory from which files
are retrieved. The Export File Directory is the directory where files created using the Export
function (in the File menu) are stored.
Header
Header setup allows you to customize your printed reports by incorporating a company logo or
graphic, as well as two lines for company address, report author, etc.
Use Header For:
Determines what pages will include the header info.
Logo Bit Map
You can include a bit map file in your printouts by pressing the File button and selecting the
file name. Silent Partner will load the bit map file at the top left of the printed page. Please
note that there is no scaling performed, so if the graphic appears too big or too small, you
must change the file using a paint program. The software allows you to load any .BMP or .DIB
bit map files.

33 | P a g e

Header Text Lines
This section allows the entry of 2 additional lines of text that will appear at the top of each
report, just underneath the logo file. These lines are also useful if you do not have a logo file to
display.

Costing
The costing feature allows you to calculate operating costs based on consumption. Silent Partner
supports both peak and off-peak rate structures. Entering the Setup menu and selecting Costing
accesses the costing functions.

To enable the costing features, check the Costing Enabled box at the bottom of the Costing
Setup Dialog box. When enabled, costing information will now appear on the kWh graphs and
tables. Costing information is stored by Silent Partner for later use, so you need only enter the
information once.
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Costing Setup
Day Rate
The Day Rate box determines the peak billing period. By definition, the Night Rate period is
the time remaining after the Day Rate period.
The Period Start slider defines when in the day the peak period begins, and the Active Period
time changes as you move the slider. The Period Length slider defines how long the peak rate
is applied. The Active period will increase or decrease as the Active period slider is moved.
If you don’t want to use an off peak rate or Night rate, slide the Period Length slider all
the way to the right. The Active Period time should now read Entire Day.
Cost per kWh ($)
Enter the cost in decimal of a kWh during peak time for your electrical utility. The actual units
of currency are determined by the International settings in Windows. If you need to modify the
currency or any other international settings, consult your Windows manual.
Night Rate
The Night rate is defined by setting the start and duration of the Day rate (see above). The
Night rate is the remaining time from the Day rate. If the Day Rate Active Period is set to
Entire day, then the Night rate cost is not used and the Night Rate Active period will be set to
None.
Cost per kWh ($)
Enter the off-peak cost in decimal of a kWh for your electrical utility. The actual units of
currency will vary depending on the International settings in Windows.
Costing Enabled
The Costing Enabled box controls whether the costing features are to be used.
Load (W)
The Load box is only used for Silent Partner Activity loggers. Since the activity logger does not
record actual kW, costing is applied according to a known load value for a piece of equipment.
For all loggers other than an Activity logger, the Load box is dimmed out. Note that when
costing is enabled the kWh($) graphs and tables are displayed instead of regular kWh. To see
simple kWh values again, simply disable costing.
Help
About

The About function displays the sign-on screen and current version number of the Silent Partner
software.
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If Things Go Wrong...
If you are having problems with your Silent Partner, consult the list of solutions that follows. If you
still have trouble, please call Northwood Power Instruments or email at info@northwoodpower.ca.
Power Calculations
I can’t get to the power setup screen when I press the Range/Power button.
•
•
•
•

Make sure you are running Silent Partner PowerPack, or Silent Partner PowerPack Plus
software. The basic software that is bundled with all Silent Partner loggers does no support
power calculations.
Make sure your data was recorded with Average recording enables (see Change Parameters
on page 26).
Check Appendix – C on page 42 to make sure you have configured your logger properly to
calculate power.
Make sure you have recorded more than one record of data.

Download Problems
The MBL will not download.
•
•
•
•

Check the download cable and make sure it is plugged into the correct communications port
on your computer.
Make sure you have selected the correct COM port in the Setup section of the software (see
page 28).
If you are downloading at 19200 baud, try setting the communication speed down to 9600
baud (see page 28).
Try toggling the XON/XOFF handshaking control (see page 28).

The software reports an “Invalid Wakeup Response.”
•

This message is most often displayed when the software tries to communicate with
something other than a Silent Partner logger. This is sometimes due to an internal modem or
some other device responding when the software is tries to initiate a conversation. If this
happens, go back in to the Setup - Logger Serial Port section and choose a different port.

“Scan Ports for Logger” says that no logger was found.
•
•

•

Make sure the download cable is plugged in before pressing the scan button.
If you have unplugged a serial mouse and then plugged the logger into that port, it probably
will not work. The reason for this is that the Windows mouse driver will report that the port is
still in use by the mouse, regardless of whether or not it is physically connected. If this
happens, Windows will not allow Silent Partner to use that port for communications. This can
be overcome by using a different port for the logger if available, or by buying a second serial
port (they are quite inexpensive).
Ensure that the port you are using actually works. Although most newer PC’s are equipped
with two serial ports, it is not unheard of for the second port to be defective. Connectors are
sometimes put on the outside of the case that aren’t actually connected to anything inside.
The best way to verify that the port is indeed working is to try communicating with some other
device such as an external modem.
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Time and Date
The time and date on all of the graphs and printouts is wrong.
•
•
•

Make sure you have set the logger's clock using the Set Time and Date function in the
software (see page 24 for details).
Ensure that your computer's time and date are set correctly.
Make sure that you press the RESET button on the MBL to begin logging.

All of the times on the graphs and reports are in 24 hour format, but I want 12 hour format (or vise versa).
The dates appear in the wrong format.
•

The way in which times and dates are displayed in the Silent Partner software is determined
by the International Settings portion of Control Panel In Windows. To change the settings,
open the Main program group and select Control Panel. Select the icon for International
Settings, and adjust the time and date formats to suit your preference.

Printing
I click on the cancel button when printing, but the printer keeps on going.
•

Printing can continue after hitting the cancel button for several reasons. Firstly, Windows has
a feature called Print Manager which acts as a background print spooler. The function of a
print spooler is to allow printing in the background, freeing up your computer for more
important things. If Print Manager is enabled, the Silent Partner software will print to Print
Manager instead of the printer. Print Manager, in turn, will send the data to the printer
leaving the computer free for other tasks. Pressing cancel will stop data from going to Print
Manager, but it will not stop Print Manager from sending the data it already received to the
printer. To remedy this situation, you can cancel the print job by selecting Print Manager from
the Main program group. Select the proper print job from the list and delete it. If you wish to
disable Print Manager and print directly to the printer, it can be disabled by opening the Main
program group and selecting Control Panel. Next, select the Printers icon, and uncheck the
Use Print Manager box on the bottom left hand side of the dialog box. For full details on the
correct use of Print Manager, please consult your Windows Manual.

•

You printer may also continue to print if it has a large amount of on-board memory. This
memory serves the same purpose as Printer Manger by providing a temporary storage space
for the printed data so the computer can move on to more important tasks. If your printer
continues to print after pressing Cancel and Print Manager is disabled. Try resetting your
printer. This should clear any data stored in the printer. If your printer does not have a reset
switch, turn the printer off, then on again.

Display
The colours on the Graph are difficult to see on the screen.
•

Please refer to appendix A for details on changing some of Silent Partner’s Graph colours.
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Logger Hookup
The L1 Power LED doesn't light when the MBL is plugged into the socket.
•

•
•
•

When the MBL has been properly installed and the neutral connected correctly, the L1 Power
LED should be lit. The LED indicates that there is voltage present on L1, and that the unit is
being powered from the line. If the LED is not lit, verify that the neutral connection is properly
secured.
If you can read 120V from L1 to neutral, there is a problem with the MBL to neutral
connection.
If you read 0 volts from L1 to neutral and 120V from L2 to neutral, then there is a problem
with L1.
If you read 240 volts from L1 to L2, the problem is likely a loose or missing neutral.

•

The absence of the L1 Power LED can also be an indication of a loose or missing neutral
from the utility transformer to the meter socket.

•

If the lack of power on L1 is a temporary situation, remember that the MBL will operate from
battery power for approximately 3 days when fully charged.
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Appendix A - SILPRTNR.INI File Settings
Silent Partner software stores most of its configuration information in a special file called SILPRTNR.INI.
This file can be edited using Notepad or any other text editor. This file should only be modified by
advanced users.

Customizing Graph Colours
If the colours used in the measurement graph aren't to your liking, you can change the colours used by
Silent Partner. Each colour is defined by the amount of RED, GREEN, and BLUE. To changes the colours,
you must edit the sections below in boldface type:
[GraphPref]
OnRGB=0, 0, 64
Plus)
1-99RGB=0,255,255
Plus)
OffRGB=255,255,255
Plus)
MaxDaySel=0
OverviewStyle=1
PeriodSel=5
MeasYAxis=1
Meas1RGB=255, 0, 0
Meas2RGB=0, 0,255
GridRGB=206,206,206
Meas3RGB=0,255, 0
Meas4RGB=128,128,128
Meas5RGB=0,255,255
Meas6RGB=255, 0,255
Meas7RGB=255,255, 0
Meas8RGB=0,128, 0
Meas9RGB=0, 0, 0

Box colour for 100% ON on Overview Graph (Not Used for SP
Box colour for 1-99% ON on Overview Graph (Not Used for SP
Box colour for 100% ON on Overview Graph (Not Used for SP

Channel 1 trace colour for Minimum
Channel 1 trace colour for Average
Graph grid colour (SPT, SPPLUS, SPC)
Channel 1 trace colour for Maximum
Channel 2 trace colour for Minimum
Channel 2 trace colour for Average
Channel 2 trace colour for Maximum
Channel 2 trace colour for Minimum
Channel 2 trace colour for Average
Channel 2 trace colour for Maximum

Orientation=1

To determine which colours to use, you can experiment using Paintbrush (a paint program that comes with
Windows). After starting Paintbrush, Select the Options menu, then select Edit Colors. A box will pop up
with sliders for red, green and blue. To the right of the sliders is a number that will change from 0 to 255 as
you move the slider from left to right. As you move each of the sliders, the box on the extreme right will
change colour. Move the sliders around until the box is the colour you want, then note the numbers beside
the red, green and blue sliders. These are the numbers you will enter into the SILPRTNR.INI file using the
text editor, Simply replace the old RGB values with the new ones.
The remaining items in the file reflect the various options that have been selected while using the software.
They can also be edited, but it is probably easier to just change the option from within Silent Partner.
[ComPort]
Port=1
Type=1

Communications port number
Default Logger Type.

[Directory]
Data=C:\SP\DATA
Export=C:\SP\EXPORT

Default directory for data storage and retrieval
Default directory exported data

[Costing]
Enabled=1
Rate=0.080000
Load=6000.000000

Costing Display 1=On, 0=Off (SPA)
Electricity cost per kWh, in dollars
Load value in Watts for calculating costing

[Measurement]
MConvert=1
MConvert1=2
MConvert2=1
[Options]
BattWarn=Status,Param
LoBattV=8.0
low battery
[PrintPref]
LogoSummary=1
Summary Page
LogoStats=1
Page
IncludeBitMap=1
BMPFile=C:\TECH5CL.BMP
LogoL1=
LogoL2=
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Battery voltage after which Silent Partner will warn of a

1=Print Logo on Summary Page, 0= don’t print logo on
1=Print Logo on Stats Page, 0= don’t print logo on Stats
1=Use bitmap file specified below, 0= don’t use bitmap file
Name and path of bitmap logo file used on reports
Text on first line after logo
Text on second line after logo

Appendix B - SPPOWER.INI File Settings
Customizing Silent Partner Power Calculations
The following section is intended or advanced users, and allows you to set some of the
computational features of the power software. Silent Partner refers to a special file called
SPPOWER.INI for all of the drop down dialog boxes. These entries can be edited to add custom
line voltages, power factors, etc. If you Use Windows Notepad or a similar editor, the file should
look something like this:

;Silent Partner Power Value File
[Defaults]
V1Phase=110, 120, 220, 240, 347
V3Phase= 208, 380, 415, 600
HVRatio=11kV:110, 11kV:240, 1000:110
LoadType=Office 0.9, Factory 0.85, Refrigeration 0.8, Heating 1.00, Lighting 1.00, Motor 0.80
ExtCT=100:5, 200:5, 300:5
kWhPeriod=15

V1Phase=
V3Phase=
HVRatio=
LoadType=
ExtCT=

kWhPeriod=

Lists the voltages that appear in the Voltage Range box for single phase supply types.
Lists the voltages that appear in the Voltage Range box for three phase supply types.
Lists the PT ratios that appear in the PT Ratio box. Each entry is in the format <primary
voltage>:<secondary voltage>. A comma separates individual entries.
Lists the pre-defined Power Factor values that appear in the Load Type (PF) box. Each entry is in
the format of <description> <space> <Power Factor value>
Lists the CT ratios that appear in the External CT box. Each entry is in the format <primary
voltage>:<secondary voltage>>. A comma separates individual entries.
Defines the calculation period in minutes used when computing kWh. This value is set to 15 in
North America, 30 for Europe.

Changes to the SPPOWER.INI file should be undertaken with caution, since incorrect entries
could cause erroneous calculations.
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Appendix C – Power Configurations and
Calculations
Very Important:
You must enable Average recording in the Logger Setup section in order to calculate power. If
you record only min/max information with your logger, you will not be able to select the power
setup dialog box. Refer to page 26 for more details on setting logger parameters.

Loose Neutral Calculation
The loose neutral LED and the loose neutral marker in Silent Partner software are determined
using the following:

(L2LSetpoint − L 2 LTol ) > Line to Line Reading > (L2LSetpoint + L 2 LTol )AND( L1 − L 2

> Line Diff

)

where :
L1:
L2:
L2L Setpoint:
L2LTol:
Line Diff:

= Line 1 voltage.
= Line 2 voltage.
= Line to line Setpoint (default is 240).
= Allowable line to line voltage deviation.
= Allowable difference between line 1 and line 2.

High/Low Voltage LED Calculation
The high/Low LED is set when the following conditions are met:

 L2LSetpoint

 L2LSetpoint

− HLVTOL  > Line1Reading > 
+ HLVTOL 

2
2




OR


 L2LSetpoint
 L2LSetpoint

− HLVTOL  > Line 2 Reading > 
+ HLVTOL 

2
2




where :
L1:
L2:
L2L Setpoint:
HLVTol:

= Line 1 voltage.
= Line 2 voltage.
= Line to line Setpoint (default is 240).
= Allowable line to neutral voltage deviation.

Average Calculations
Storage Interval
1 second
2 seconds
3 seconds
4 seconds
5 seconds
6 seconds
7 seconds
8 seconds
9 seconds
10 seconds
20 seconds
30 seconds
40 seconds
50 seconds
1 minute
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Samples/Average
4
8
12
16
20
24
28
32
36
40
80
120
160
200
240

Storage Interval
2 minutes
3 minutes
4 minutes
5 minutes
6 minutes
7 minutes
8 minutes
9 minutes
10 minutes
11 minutes
12 minutes
13 minutes
14 minutes
15 minutes

Samples/Average
480
720
960
1200
1440
1680
1920
2160
2400
2640
2880
3120
3360
3600

Current and Voltage Combinations for Calculating Power (N/A for MBL)
Silent Partner is very intelligent and can generally determine what metering systems are
appropriate depending on the way the logger has been configured. Below is a chart that explains
how to configure your logger depending on the voltage distribution system you want to monitor:
If you want to monitor:
1P2W System
1P3W System
3P3W System
3P4W System

Configure your logger to record:
1 current or 1 current & 1 voltage
2 currents or 2 currents & 1 voltage
1 current or 3 currents
1 current or 1 current & 1 voltage or 3 currents

IF YOU CONFIGURE YOUR LOGGER DIFFERENTLY, YOU WILL NOT BE ABLE TO ACCESS
THE POWER SETUP AND DISPLAY FUNCTIONS!
Looking at it another way, the chart below explains what power calculations are possible for a
given logger setup:
If you record:
1 Voltage
2 Voltages
3 Voltages
1 Current
2 Currents
3 Currents
1 Current, 1 Voltage
2 Currents, 1 Voltage
1 Current, 2 Voltages

Silent Partner can calculate power for:
No power calculations allowed.
No power calculations allowed.
No power calculations allowed.
1P2W(I), 3P3W(I), 3P4W(I)
1P3W (2xI)
3P3W (3xI), 3P4W (3xI)
1P2W (I), 1P2W (I+V), 3P3W (I), 3P3W (I+V), 3P4W (I), 3P4W (I+V)
1P3W (2xI+V), 1P3W (2xI)
1P2W (I), 1P2W (I+V), 3P3W (I), 3P3W (I+V), 3P4W (I), 3P4W (I+V)

PowerPack Calculations (N/A for MBL)
Silent Partner PowerPack calculates all power values according to the following formulae:
1P2W – 3P4W
1 Current

VASSUMED × I × PF (multiply x # of phases for Total power)

1 Current, 1 Voltage

VPHASE − NEUTRAL × I × PF (multiply x # of phases for Total power)

3P3W
Using 1 current
(assumes balanced load)

3 × V ASSUMED × I × PF (Total Power)

Using 1 current, 1 voltage

3 × VPHASE − PHASE × I × PF (Total Power)

(assumes balanced load)
Using 3 currents

VASSUMED × I × PF
(Multiply by 3 for Total Power)
3
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Appendix D – LMR’s & Silent Partner Power Pack
Silent Partner provides download, display, print, storage, and file export support for LMRA300,
LMRA500, LMRA1000, LMRA1000/3 current loggers in single integrated Windows application.
To install the software:
•
•
•
•
•

Make sure that your computer is running Windows.
Insert the Silent Partner distribution disk in drive A: (or drive B:).
Select Program Manager (or click the Start button in Windows 95).
Select Run from the File menu (click Run in Windows 95).
In the Command Line dialog, type "A:\SETUP" (or "B:\SETUP").

Setup will ask if you want to change the default name of the installation directory. After you click
on OK, Setup will begin installing the software to your hard drive. A program group called Silent
Partner will be created containing the Silent Partner icon. As with any Windows application, the
Silent Partner software is run by double clicking the icon with the mouse.

Software Setup
1. Select the Setup menu.
2. Select Logger Serial Port.
3. Select the correct communications port from the selection box.
4. Select LMR from the Select Logger Type box.
5. Press OK.
Downloading
1. Select the Logger menu.
2. Select Download.
3. Silent Partner will download all available data.
Important Notes for Current Trend Users:
Silent Partner differs from Current Trend in several respects:
•
•
•

Merging of several single phase data files into one three phase survey is not supported.
Totalization of all three phases is not supported for LMRA1000/3.
LMRA1000/3 files are not saved as separate files for each channel; all three channels are
saved in a single file.

These differences can be overcome by using the Export file feature to perform your calculations
in Lotus 123 or Excel.
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Appendix E – ERA, Dura, Broy, Rochester
Loggers and PowerPack
Software Setup:
1.
2.
3.
4.
5.

Select the Setup menu.
Select Logger Serial Port.
Select the correct communications port from the selection box.
Select ERA or DURA from the Select Logger Type box.
Press OK.

Logger Setup:
1.
2.
3.
4.
5.

Select the Logger menu.
Select the Change Parameters screen.
Change the storage interval etc. to your liking.
Press OK.
Silent Partner will send the new setup and start time.

To Set the Current Time Only:
1.
2.
3.
4.

Select the Logger menu.
Select Set Time and Date menu.
Press OK.
The software will send new start time, based on the PC’s clock time.

To Download:
1.
2.
3.
4.
5.

Set the transfer switch on the ERA Interface to Idle, and the RS232 switch to ERA.
Select the Logger menu.
Select Download.
Toggle the Transfer switch to Transfer when instructed to do so.
Software will download all available data.
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Appendix F – MBL Specifications
Specification
Number of Channels
Ranges

External Connections
Sensor Type
Sample Rate
Storage Rate
Parameters Stored

Five
Channel 1 and 2
Channel 3
Channel 4 and 5

0-150 VAC
0-300 VAC
0-225 Amps

All readings True RMS
Internal RESET and
SLEEP switches.

Opto-isolated RS232C.
Voltage-internal impedance network, Current – internal CT’s
¼ Second.
1 second to 15 minutes.
Average, Min/Max, or Min/Max/Average.

Memory
Memory Treatment

512K bytes.

Storage Capacity
Indicators

512K
External: Loose neutral, Low/High Voltage
Internal: Flashing Recording LED, L1 voltage/power LED

Stop when full, or wrap.

Power
Line powered with internal rechargeable battery for backup.

Battery Life
3 days typical with fully charged battery.
Input Impedance

Charging Current
Communications
Software

Packaging
Accuracy
Resolution
Safety
Weight
Dimensions
Environmental

Notes

Set via Silent Partner
software.
Set via Silent Partner
software.
Non-volatile flash memory.
Set via Silent Partner
software.
See Memory Usage chart
.
Uses rechargeable battery.
Can be recharged via
external power adapter
(approximate recharge time
8 hours).
NiCad battery standard, 40° model uses lead-foil
battery.

Channel 1 to Neutral - 3.6 KΩ
Channel 2 to Neutral - 317.5 KΩ
Channel 1 to Channel 2 - 322.5 KΩ
Quick Charge - 120 mA
Trickle Charge - 6 mA.
Optically isolated RS232, support for remote setup.
Silent Partner PowerPack power calculation software for
Windows.
Water tight (with meter affixed). Rugged, durable ABS.
Voltage: ±0.3% Full Scale, Current: ±0.3% Full Scale.
0.1V, 0.1A
Optically isolated download, CSA Special Inspection.
2.5 lbs. (MBL20) 3.25 lbs.(MBL40).
7" diameter x 5" deep (7" dia. X 6" for MBL40l).
-20°C to 60°C, or -40°C to 60°C (- 40°F to 140°F) extended
temp range, Relative humidity - to 90% non-condensing.

Requires PC running
Windows 3.1 or greater and
1 free serial port.
All components conformally
coated.
12-bit A/D converter.

Specifications Subject to Change without Notice
CSA labeled loggers inspected under the CSA Special Inspection service.

Memory Usage
Mode
Avg. Only
Min/Max
Min/Max/Avg.

46 | P a g e

Maximum Number of Records
69,552
34,776
23,184

Index
?
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Delete · 19
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Download Data · 25
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E
Export · 19
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12
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File · 18
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Logger Hookup ·
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Logger Serial Port ·
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H
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34
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I
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… · 36
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Neutra · 14
Installing
PowerPack · 17

L
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L2LTol · 6, 43
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47
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Load (W) · 35
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Logger · 24

Measurement
Graph · 22
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23
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meter socket · 1, 3,
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Basics · 10
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ML Options · 29

N
Network Service ·
11
neutral · 1, 4, 5, 7,
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Neutral … · 27, 31
neutral socket · 13
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Night Rate · 35

O
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P
phase shift · 8, 9
Power L1 XE "LED"
LED · 2
Power L1 LED · 3,
10, 12, 14
Print · 19
PT Ratio · 32

Q
quick charge · 16,
47
Quick Start · 3

R
Range · 27, 33
Range (P-N) · 32
Range (P-P) · 32
Range button · 21,
25, 27, 32, 33,
36
Range/Power · 32
Read Status · 25
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recharging · 1, 16,
28
Recognizing
Common
Problems with
Residential
Distribution · 5
Recording LED · 1,
47
reset button · 3, 10,
37
Residential Power
Distribution · 4

S
Samples · 26
Save · 19
Save As · 19
Scan Ports for
Logger · 29
Sensor · 28
Set Time and Date ·
24
setpoint · 7, 8, 27,
31, 43
SETPOINT · 6
Setup · 28
short lead · 13

sleep button · 3, 15
Source · 32, 33
Supply Type · 32
Survey Description
· 29
Survey Summary ·
21
System
Requirements ·
17

T
time and date · 17
Tolerance (+/-V ·
27, 31
Trace Selections ·
30
trickle charge · 16,
47

Using Silent
Partner
Software · 17

V
View · 20
Voltage · 32

W
Wraparound Mode ·
26

X
XON/XOFF · 29

U

Z

Update · 28
Use Header For: ·
33

Zoom · 24

Notes:
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